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ERA V 3.0 FAQ’s (for Regular Learning and IPT Process) 

 FAQ’s for Learning Facilitator 

 Before Installing ERA V 3.0 

1.      What is the recommended setup and prerequisites for installing the ERA V 3.0 
Framework? 

The recommended setup for the installing the ERA V 3.0 is 

o   There should be at least 6 GB of space for the installation. 

o   Recommended platform. 
  Windows Server 2003 or Window XP with IIS 6.0 or 5.1 
  .Net framework 2.0 (This will be installed if not available) 
  You will need to confirm configuration of ERA web for .Net 2.0 
  MSDE (This will be installed as separate instance) 

o   Recommended Browser - Internet explorer 6.0 and above. 

o   Make sure that you have admin rights for installation. 

o   The database will be removed automatically during uninstall. 

2.      Which is the recommended Operating System for installing ERA V 3.0? 
o   Windows Server 2003 Standard Edition is highly recommended for the installing ERA V 3.0. 

o   The service pack 2 should be installed 

3.      Where should I install the ERA V 3.0? 
o   ERA V 3.0 should be installed on the server machine of the Local Area Network wherein the 

operating system should be Windows Server 2003 Standard Edition or Windows XP, with 
Service Pack 2. 

4.      How much space will be required for installing ERA V 3.0? 
o   Approximate 6 GB space (on the drive where Operation System is installed) will be required 

for installing ERA V 3.0. 

5.      Is there any specification for the number of PC’s in the LAN/LAB/Network? 
o   No, there is no restriction on the number of PC’s in the LAN/Lab/Network. 
o   If ERA is installed on Windows XP then:- 

  Windows XP does not support more than 5 clients. 
  If you want to access the ERA on more than 5 clients/machines then install the 

ERA on Windows Server 2003. 

6.      Does ERA V 3.0 work in wireless LAN setup/environment? 
o   Yes, ERA works in the wireless LAN/LAB/Intranet environment. 

During ERA V 3.0 Installation 

7.      Is it required to install .NET Framework and which version? 
o   Yes, Microsoft .NET Framework 2.0 is required to be installed. 
o   .NET Framework 2.0 will get installed at the time of installation from ERA V 3.0 DVD if it’s not 

already installed. 
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8.      Is internet connectivity required while installing ERA V 3.0? 
o   No, Internet connection is not required for ERA V 3.0 Installation. 

9.      Is internet connectivity required while activating ERA V 3.0? 
o   Internet connection is required for ERA V 3.0 Activation. 
o   Internet connection is also required for downloading the Learner data from Central ERA V 3.0 

Server. (refer ERA V 3.0 Learning Facilitator Guide for more information) 

10. Is it required to install any database application? 
o   MSDE (Microsoft SQL Server Desktop Engine) will be installed from ERA V 3.0 DVD if it’s not 

already installed. 

11. Is there any difference between the ERA Installation and ERA Activation? 
o   Yes, there is difference between the Installation and Activation. 

  Installation: - ALC Installs ERA V 3.0 from the ERA V 3.0 DVD given by the RKCL, by 
which the software framework gets installed; however it will be available for use 
only after its activation 

  Activation: - ALC activates ERA V 3.0 by clicking the Activate button on the 
Learning Facilitator login screen. Only after activation ALC can use the ERA V 3.0 

12. What are the prerequisites for ERA V 3.0 Activation? 
o   Following are the prerequisites for ERA V 3.0 Activation 

  Successful installation of ERA V 3.0 
  Time Zone of the server machine where you are installing the ERA V 3.0 should be 

Indian Standard Time (Chennai, Mumbai, Delhi, Calcutta) 
  System date and time of the server machine where you are installing the ERA V 

3.0 should be set to current 
  After doing above changes try to for ERA V 3.0 Activation 

13. I have problem while installing the IIS. Insert Disk message is displayed while 
configuring the IIS. Which CD should I insert? 

o   If the following screen is displayed to you while configuring the IIS, read the message 
carefully and insert the Operating System installation CD. 
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14. While Installing the ERA V 3.0 following error screenshot are displayed, what should be 
done to resolve this? 

 

This issue comes when ASP.NET user does not have the rights to access the specified file to resolve this 
issue do the following. 

o   Go to the C:\inetpub\wwwroot 
o   Select the RSCIT-ERA3 folder and right click 
o   Go to properties 

o   Select Security Tab 
o   Add the ASP.NET user and give full access 

o   Click Apply and OK button. 
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15. While installing ERA 3.0, QuasiOES Server I am getting the following error. 

 

o   This error message comes because Microsoft SQL Server 2005 is already present in your 
machine. 

o   To remove Microsoft SQL Server 2005 do the following: 

o   Go to Control Panel, select Add or Remove Program. 

 

o   Go to Change or Remove Program Tab and remove Microsoft SQL Server 2005. 
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o   Now try installing the QuasiOES Server again from the ERA 3.0 DVD. 
o   In the DVD go to ERA3.0 >> ERA_QOES_Installer and 

run ERA_QOES_Installer application. 

 

o   Even now, if you get the same error, then format the machine and install ERA 3.0, 
QuasiOES Server again from the ERA 3.0 DVD. 
  

16. While installing ERA 3.0 QuasiOES Server, I got some error what am I suppose to do. 
  

 

o   Close the error Window. 
o   You do not need to remove the ERA 3.0 QuasiOES application from Add Remove Program. 
o   You can directly use ERA 3.0 Installation DVD. 
o   In the DVD go to ERA3.0 >> ERA_QOES_Installer and 

run ERA_QOES_Installer application. 
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17. How to give administrator rights to ASPNET user and why is it required? 
o   While Activating ERA V 3.0 an ASPNET user is required to have the administrative rights. While 

installing ERA V 3.0 the administrative rights are granted to ASPNET User. But, in case it’s not 
been granted then user might be prompted to do so while accessing the learning facilitator login 
or while activation. Following are the steps to do so... 
o   First :- Go to control panel    User Accounts 

  Select ASPNET User 
  Click on Properties 
  Select Group Membership tab 
  Select option - Other 
  Select Administrators from dropdown 
  Click on Apply 
  Restart the machine 

o   Second:- Go to My Computer  Right Click 
  Click on Manage 
  Click on Local Users and Groups 

¶         Users 

¶         Select ASPNET and Right Click 

¶         Click on the Properties 

¶         Click on Member of 

¶         Click on Add 

¶         Type “Administrator” 

¶         Click OK and Apply 
  Restart the machine 

If still same problem persist then do the following settings - 

o   Go to Control Panel 
  Click on Administrative Tools 
  Click on Computer Management 
  On the tree on left hand side of your system, click on System Tools. 
  Click on Local Users and Groups 
  Select Groups folder 
  On right hand side, right click on Administrators 
  Select Add to Group… Click on Add… button 
  Click on Advanced… button 
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  Click on Find Now 
  In searched result list in column Name (RDN) Select NETWORK SERVICE 

¶         Click on OK button 

¶         Click on OK button 

¶         Click on OK button 
  Now restart your machine and run the ERA-Learning Facilitator shortcut key. 

Accessing ERA V 3.0 

18. Do I need to install any client for accessing the ERA V 3.0? 
o   Yes, for taking the IPT you need to install ERA Quasi OES Client in every client machine. 

o   To install the ERA Quasi OES Desktop Client do the following : 
  Log in on the Client machine using Learner Facilitator’s login. 
  Click on Tutoring >> Install Quasi Online Exam Client. 

 

o   Check the point No.46  for more information in this FAQ Document. 

19. I have installed ERA V 3.0 successfully. The eContent is not visible to the learner, he is 
using Firefox or Chrome or Opera Web Browser. What should I do? 

OR 

20. Which Web Browser is required for accessing ERA V 3.0? 
o   Internet Explorer 6.0 is highly recommended for accessing ERA V 3.0. 

o   eContent will not visible in any other browser. ( Firefox, Chrome etc) 

21. While learner tries to see the eContent he gets the error that you are not authorized to 
view complete course content. What am I suppose to do? 

o   This error message comes when the eContent is not loaded. 

o   Load the content using the ERA eContent CD. 

22. What can I do if ERA V 3.0 is not accessible from one of the machine in the network? 
o   Check the LAN connectivity first; check that all PC’s are accessible from the server machine 

and vice a versa. 

o   Disable the firewall setting of Client and server. 
o   Try adding URL for accessing ERA V 3.0 Learner login in Trusted and Intranet sites. 

  

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_create
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23. I have Windows Vista on the Client machine in the network, will there be any problem 
for accessing the ERA. 
o   No, there will not be any problem for accessing the ERA V 3.0. 
o   The perquisite for accessing the ERA V 3.0 from the client machines are as follows 

  The client machine should have the Internet Explorer 6.0. 
  For taking the IPT you need to install ERA Quasi OES Client. 
  To install the ERA Quasi OES Desktop Client do the following : 

¶         Log in on the Client machine using Learner Facilitator’s login. 

¶         Click on Tutoring >> Install Quasi Online Exam Client. 

 

o   Check  point No.46  for more information in this FAQ Document. 
o   The ERA V 3.0 should be installed on Windows Server 2003, after successful installation ERA 

can be accessed from the client machine having Windows vista or Windows XP. 

o   You can access ERA V 3.0 on the client machine using following URL 
  Learning Facilitator:- http://<<server machine name>>/RSCIT-ERA/sysindex.aspx 
  Learner :- http://<<server machine name>>/RSCIT-ERA/index.aspx 

  

24. When I try to log as Learner Facilitator, following message is displayed “Synchronize 
Date”.  What I am supposed to do? 

  

o   This messages comes when your ERA server machine date is changed to either previous 
than last login date. In that that case follow below mentioned process. 

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_reinstall
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o   On LF Login page, click on the Synchronize Date link. 

 

o   You will get the following message 

 

o   Change your system date to the date mentioned in the message above. 

o   Now delete the cookies and the Temporary internet files from your machine. 

o   For this do the following : 
  In the Internet Explorer go to  Tools >> Internet Options 

  

 
                
  

  Go to General  Tab >> Browsing History >> Delete button 
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  Click on Delete Cookies and Delete files… buttons 
  
  

 
  

o   Restart the machine 

o   Try login again 
  

  

25. I have installed ERA V 3.0 successfully but after two to three days “ExecuteReader 
requires an open and available Connection. The Connection’s current state is closed.”  
error is coming? 
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OR 

I get the error message “Cannot find table 0” in learner or LF login, what should I do? 

 

Solution 1: 

o   The above error comes when the database services for the ERA V 3.0 Application are Stopped 
or Paused. 

o   To resolve this problem do the following steps. 
  Go to Start RUN 
  Type “services.msc” 
  And start the services for MSSQL$ERA3. 

Solution 2: 

o   ERA files might have got corrupted. 
o   Take manual Backup of ERA (Refer Point No.69 in this document for details) 
o   Re-install ERA 3.0, activate it and try logging in LF and Learner login, if no such error comes 

then restore the manual backup (Refer Point No.69 in this document for details) 

o   After restoring try logging in LF and Learner, now if error comes then it means the database 
have got corrupted. 

  

Solution 3: 

o   The data base itself got corrupted. 
o   eMail the manual backup files (.mdf and .ldf files) to the era support id. 
o   If possible, we will correct the data base backup, and send the files back to you. 
o   You need to reinstall ERA again and restore these files corrected files. 

  
  

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_take
http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_take
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26. I have installed ERA V 3.0 successfully but after clicking on the Learning Facilitator icon 
or on the learner icon following error is displayed? 

 

o   The above error comes when the .NET framework 2.0 is not configured for the ERA V 3.0 
application. 

o   To resolve this problem do the following steps. 
  Go to Start RUN 
  Type “inetmgr” 
  Under the Web Sites 

¶         Default Web Sites 

¶         Click on the RSCIT-ERA3 

¶         Right Click and select the Properties 

¶         Click on the ASP.NET tab 

¶         Select the ASP.NET version 2.0.50727 

¶         Click Apply 

  

27. I have installed ERA V 3.0 successfully but after clicking on the Learning Facilitator icon 
or on the learner icon nothing is happening? 

  
o   This problem may come when the java script is not enabled. 
o   Go through the following steps 

Or 

28. How to enable the Scripting Language in the internet explorer. 
o    To enable JavaScript in Microsoft Internet Explorer 5.x or 6.x, perform the following steps: 
1.     From the Tools menu, click Internet Options. 
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2.     From the Security tab, click Custom Level. 

 

The Internet icon is highlighted by default. 

3.     Scroll to Java permissions, click to select High safety. 

 

4.     Click OK. 
5.     Click OK. 
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6.     From the File menu, click Close. 

 

29. I have installed the ERA V 3.0 successfully on Windows XP, but after accessing the ERA V 
3.0 on more than 5 machine/Clients simultaneously it’s not working properly. 

o   It’s due to the limitation in Windows XP operating System. 
o   Windows XP does not support more than 5 clients. 
o   If you want to access the ERA on more than 5 clients/machines then install the ERA on 

Windows Server 2003. 

30. I have Installed ERA V 3.0 and downloaded the learners but following error message is 
displayed while learner login. 

  

 
o   This error comes when the system date is not within the course duration. 
o    To resolve the issue :- 

  Check the System date and time. 
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¶         System date and time should be current and Indian Standard Time 
respectively. 

Or 
o   Re-download the learners and restart the machine and then check. 
o   Also check that you have selected the correct Time Zone (Chennai, Kolkata, Mumbai, 

Delhi) while setting date and time. 
  

31. I have installed ERA V 3.0 successfully but I get following error message “Cannot find a 
version of the runtime to run this application ” while using the Data Traveler. 

 
  

o   This error occurs because virus corrupts the .exe file of the Data Traveler. 
o   This error does not affect the LF or Learners login. 
o   In this case you can take manual backup. (For steps of taking Manual Backup, please 

refer point number 69 of this document). 

o   Whenever you will reinstall ERA 3, this error will be removed. 
  

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_take
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32. Thread was Being Aborted Error is coming? 

 

o   This error comes when the system is not able to access the files or pages. The request is 
getting timeout. 

o    To resolve the issue :- 
  Go to following folder on the Server Machine 

C:\inetpub\wwwroot  RSCIT-ERA3 

Right Click and Click on Security 

1.       Click on Add Button 
2.       Now type Network Service and Click on Check name 
3.       Click Add and Ok button. 
4.       Give Full Access to this user 

Or 
  Go to following folder on the Server Machine 

C:\inetpub\wwwroot  RSCIT-ERA3 

5.       Right Click and Click on Security 
6.       Click on Add Button 
7.       Now type aspnet  and Click on Check name 
8.       Click Add and Ok button. 
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9.       Give Full Access to this user 

33. If the learner is viewing the eContent in more than one language, then how is his total 
time spent in learning calculated? Or Learner has viewed eContent in Hindi and English 
language then how his/her learning completion is calculated? 

  

o   Learning is captured on following two parameters 
1. Time Spent and 
2. eContent Viewed 

  
Time Spent is calculated as follows 
  

o   The time spent by the learner in all the language is added up. 
o   For example, if a learner has viewed the eContent in English language for 1 hour, Marathi for 

2 Hours and Hindi for 1 hour, then his/her total time spent in learning is 1 + 2 + 1 = 4 hours. 
o   You can view this time spent in the Learning Duration Report (this excludes the time spent in 

forum, chat, ePortfolio etc). 
o   You can see this report in Learning Facilitator’s login Tutoring >> Reports >> Learning 

Duration Report. 

 

 

Learning Completion is calculated as follows 

o   Topic wise maximum completion percentage is considered. For example if any learner has 
completed 30% of word processing in English and same topic he/she has completed in 
Marathi with 70% completion then 70% for that topic will be considered automatically. 
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o   And like wise over all course completion will be calculated. 

Note: - only following courses are considered for course completion 

¶         RSCIT with MS Office English, 

¶         RSCIT with MS Office Hindi 

34. The time spent by learner on ERA V 3.0 is not getting updated. What am I suppose to 
do? 
o   You can see the time Learner spent in learning (this excludes the time spent in forum, chat, 

ePortfolio etc) in the Learning Duration Report. 

o   You can see this report in Learning Facilitator’s login Tutoring >> Reports >> Learning 
Duration Report. 

o    For example in the following Learning duration Report, Learner Bhavna has spent 58 Minutes 
15 Seconds in Learning. 

 

o   Learning Duration Report gets updated only after the following conditions are fulfilled 
  The learner has logged out of ERA V 3.0 from the Home page of his login. 
  The learning Facilitator has uploaded the Learning Records. 

o   Learning Records can be uploaded through Learning Facilitator login Academics >> Upload 
Manager >> Upload Learning Record 

 

o   Duration spent report shows the total time spent by a learner in his log in (this includes the 
time spent in forum, chat, ePortfolio etc). 

o   You can see the Duration spent Report in Learning Facilitator’s login Tutoring >> Reports >> 
Duration Spent Report. 
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o   For Example, learner Bhavna has spent 1 hour, 32 minutes, 45 seconds in ERA V 3.0, and out 
of this time she has spent 58 Minutes 15 Seconds (as indicated in Learning Duration Report) 
in learning. She spent rest of the time in forum, chat, ePortfolio etc. 

 

35. While accessing eContent in ERA 3.0 following error message is displayed “There are 
too many people accessing the website at this time”. What am I suppose to do? 

 

o   This message is displayed because 
  The operating system on the server machine is Windows XP,(which supports 5 clients) 

and more than 5 users are trying to accessing ERA V 3.0 at the same time. 
OR 

  Check if the intranet/LAN band width is sufficient to handle the load. 
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  If you want that more than 5 client needs to be connected the Server operation 
system should be Windows Server 2003. 

36. ERA V 3.0 is installed successfully learners were viewing the eContent and all the 
processes were running smoothly. But now the Learners login page gives the message 
‘System is not activated.’  Now when I  tried to activate the center, I am getting following 
messages.What should I do? 

  

o   Solution 1: 
  Try removing the Cookies, Temporary Internet files and History from your machine 

using the Tools Menu. 
   Restart your machine and try. 

o   Solution 2: 
  Your machine must have got infected by a Virus. 
  Go to Start >> Run 
  Enter regedit and click on OK. 
  Go to HKEY_LOCAL_MACHINE\SYSTEM\MountedDevices 
  Right click on MountedDevices and select Permissions… 
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  Give Full Control Access to the user Administrator. 
  Restart the machine. 
 

o   Solution 3 :  
  Uninstall ERA V 3.0 from your machine and install it again. 

37. When the learner tries to upload a file for an ePortfolio activity, he is getting the error 
‘Access to the path ‘C:\inetpub\wwwroot………. Is denied’. What should be done to 
resolve this problem. 

  

 

o   You need to go the path mentioned in the error on Server machine i.e 
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  C:\Inetpub\wwwroot\RSCIT-ERA3\e-Portfolio\PortFolioContent\1 
  If folder Assignments is not present create a folder with the name ’Assignments’  and 

give full access to the user ASP.NET. 
  Try uploading the file again. 

Learner Downloading 

38. When I try to connecting to Central ERA Server (for Activation, Learner download, 
Learning record uploading etc), following error message is displayed “The remote 
name could not be resolved ‘era.mkcl.org’.”  What am I suppose to do? 

  

 
  

OR 

  

I get the following error ‘Redirect URI cannot contain newline character’. What am I suppose 
to do? 
  

 

Solution 1 

  If Windows is installed in D: or E: , then the path will change accordingly. 
  Disable the firewall 
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  In case you are using any Antivirus – disable it 

After doing all the settings restart the machine and try accessing ERA again. 

Solution 2 

If the error still persists do the following. 

o   You may encounter this error because of the DNS server issues with ISP.    
o   Please check the following 

  Go to Start >> My Network Connections. Click on ‘View network Connection’ 

 

  Right click on the LAN icon and select Properties. 

 

  Select Internet Protocol (TCP/IP) and click on Properties. 
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  Check the following : 
1.       If option ‘Obtain an IP address automatically’ is selected 

a.       Option ‘Obtain DNS server address automatically’ should be 
selected’. 

 

2.       If option ‘Use the following IP address’ is selected, then, 
a.       By default ‘Use the following DNS server addresses’ is selected. 
b.      There should be entries for all the 5 fields. 
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c.       If any entry is missing contact your system admin.  
  Now, check if your machine can ping www.google.com and www.mkcl.org. Do 

the following to check 
1.       Go to DOS prompt (Start >> Run >> cmd ) 
2.       Run command ‘ping www.google.com’, you should get reply as shown in 

screenshot. 

 

3.       Similarly run command ‘ping www.mkcl.org’, you should get reply as 
shown in screenshot. 

 

4.       If you do not get a reply, contact your system admin. 
5.       If you get the reply above, try accessing ERA again. 

http://www.google.com/
http://www.mkcl.org/
http://www.google.com/
http://www.mkcl.org/
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39. What should be the frequency to download learners data? 
o   You need to download learners only once after installing ERA V 3.0. 

o   If you have re-installed ERA V 3.0 for any reason, then you need to re-download the Learners. 

ERA V 3.0 System and Course Upgrades 

40. Where can I check the system and course updates and reference document 
o   ERA V 3.0 related updates and Reference documents can be referred on 

http://www.rkcl.in 

ERA V 3.0 Quasi OES Server/ Client 

41. “Supported files are not exists. Please contact your exam administrator.” this message 
is displayed when the learner tries to give the IPT test. What am I suppose to do? 

  

 

o   This message comes when the ERA V 3.0 Quasi OES Server is not installed on the Server 
machine. 

o   To install the ERA V 3.0 Quasi OES Server, use the ERA V3.0 DVD. 

o   In the DVD go to ERA3.0 >> ERA_QOES_Installer and run ERA_QOES_Installer application. 

 

42.  I get the following information box, while installing QuasiOES Client. 
  



 

Page 27 of 47 
Website : - http://www.rkcl.in                                               Contact : - 0141-5159700 

Corporate Office : - R.K.C.L. , 7-A , Jhalana Institutional Area , Jaipur-302004 (Raj.) INDIA 

 

o   This error comes, when Crystal Reports is not installed on the machine. 
o   To resolve this issue 

  Insert ERA V 3.0 installation DVD. 
  Go to the following folder ERA_QOES_Installer\SetupFiles\crystalreports 
  Run CRRedlist 2005_x86. Set up wizard for Crystal Report will 

start.                 
  

  After the wizard completes, you can  log in through the Learners Login and give 
the test. 

43. How to reinstall the ERAQOES server and client? 
o   Permanently delete (shift+del) the two folders in folder 2.0 of your ERA Local Server machine 

and all the client machines. 
o    The path of the folder 2.0 is C:\ Documents and Settings\ <User name of the machien>\ Local 

Settings\ Apps\ 2.0 

o   On the ERA Server machine go to Start >> Settings >> Control Panel >>  Add Remove Programs. 
o   Remove Microsoft SQL Server Desktop engine(ERAQOES) 
o    Reinstall ERA QOES Server from the ERA Framework DVD (ERA3.0\  

ERA_QOES_Installer\ ERA_QOES_Installer). 
  

44. While giving the IPT I am getting the error message ‘Application Validation did not 
succeed’. 
o   You need to create QOES Desktop Client on your machine. 
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o   The steps to create QOES Desktop Client are mentioned in Point No.46 in this document. 

45.  While giving IPT following error : ‘Application failed to initialize properly, click OK to 
terminate the application’ 
o   You need to create QOES Desktop Client on your machine. 
o   The steps to create QOES Desktop Client are mentioned in  Point No.46 in this document. 

  

46. How to create QOES Desktop Client? 
o   To create QOES Desktop Client do the following : 

1.       Go to the following folder 
C:\Documents and Settings\<Machine User name>\Local 
Settings\Apps\2.0 

 

  
2.       Permanently delete(Shift+ Del) the two folders Data and X9E1TY3R.3KH. 
3.       Now reinstall QuasiOES Client from ERA V 3.0 DVD. Following is the path for the 

setup file of QOES Client. 
Download \  ERA-QOES_Client_Installer \   ERA_Client_Installer.exe 

4.       Now the learners can use the ERAQOES Desktop client to solve the exams. 

47. If the QOES ends abruptly, then the task bar disappears. What should I do? 
o   Go to Task Manager >> Processes >> Right click on the explorer.exe and stop it. 

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_reinstall
http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_reinstall
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  In the Task Manager Go to File >>New Task (Run) and enter ‘explorer.exe’. Click on 
‘OK’. 
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ERA V 3.0 Assessment 

48. I have downloaded the learners and after clicking on the Examination link following 
message “Currently there is no new exam available to you!” is displayed in learner 
login. 

 

o   This error comes when the system date is not within the course duration. 
o    To resolve the issue :- 

  Check the System date and time. 

¶         System date and time zone should be current and Indian Standard Time 
respectively. 

Or 

o    Re-download the learners and restart the machine and then check. 
o   Also check that you have selected the correct Time Zone (Chennai, Kolkata, Mumbai, 

Delhi) while setting date and time. 

49. When the learner selects Hindi/Marathi as the language for giving the test, the content 
comes in a non readable font. What am I suppose to do? 
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o   This is because your machine does not support Hindi font. 
o   These fonts need to be installed on the machine using the Windows XP Professional CD. 
o   To resolve this issue 

  Go to Control Panel >> Regional and Language >> Language Tab 
  

 

  In the Supplemental Language Support, select the first checkbox. Click on OK of 
the alert Box. 

 

  In the Supplemental Language Support, select the second checkbox. Click on OK of 
the information Box. 
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  Click on Apply 

 

  Click on OK and insert Windows XP Professional CD. 
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50. While giving the IPT test, Learner needs to enter RKCL Learner ID.  Where do I get this 
Id from ? 

 

o   You can get RKCL Learners Id from the Learner Login Report 
o   Login using your Learning Facilitator Id. 

  Go to Tutoring >> Reports >>Learner Login Report 
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  Select the Course, Month and the Learning Start Date. This report contains the 
Learner ID. 

 

51. While giving IPT after entering learner Id and Era login Password following message is 
displayed “Either your Login is not valid or your Registration Validity Period is expired ”. 
What should I do? 
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o   This message comes in following cases : 
Case 1:- 

The password of the learner is more than 20 characters. 
1.       Ask the learner to change his password and make it less than 20 

characters. 
2.       “Change Password” link for the learner is on his/her Home Page. 

                                 

3.       Enter the Old Password, then the new Password(less than 20 
characters).Click on “OK”. 
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4.       Try giving the exam again. 
  

Case 2:- 
When the ERA V 3.0, local server name has been changed 

5.       Install QOES Desktop Client on the machine. 
6.       The steps to install QOES Desktop Client are mentioned in Point No. 46 in this 

document. 

52. Learner cannot see his IPT Certificate. 
o   There could be 2 reasons why the certificate is not visible. 

1)      Learner score is less than 40%. 
  

2)      You have not uploaded the IPT marks. In this case the learner will get a message as 
he logs in to ERA and selects the course. 

 

o   To upload the score do the following: 
  Login using your Learning Facilitator Id go to Tutoring >> Academics >>Upload Manager 

>> Upload Interim Performance Test(IPT Marks) 

 

http://elearning.mkcl.org/support/MSCIT/ERA%20V%203_FAQ_19%20May%202010.htm#_How_to_reinstall
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  Select Course, Learning Period, Learning Start Date, Exam. 
  You will get a list of learners with their Exam attempt details. 
  Select the candidate and click on Upload. 

 

  Enter the Center Password. 

 

  Message for successful upload is shown 

 

53. The Practice Tests for some topics are available only in English. What should I do, if the 
Learner wants to give the test in Hindi Language. 

o    You need to install the ERA Update 

                                          i.     SU 1.1 ï IPT Certificate and Reports  
                                         ii.     SU 1.2 ï QOES Presentation Graphics  
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o    You can get the se updates at ERAôs support website http:// rkcl.in   
o   Once you have installed these patches, all the Practice Tests will be available in all the 

three languages that is English, Hindi.  

54. While giving the IPT of PIM (Outlook), even though the learner has the solved the 
Practical questions correctly, in the end it is marked as wrong. What are we suppose to 
do? 
o   In the Practical Questions of PIM (Outlook) IPT, its mandatory to save the work done in the 

question. 
o   Before submitting the questions of PIM IPT, Learner should always click on ‘Save & Close’ 

button. 

 

55. While giving the IPT of Presentation Graphics, even though the learner has the solved 
the Practical questions correctly, in the end it is marked as wrong. What are we 
suppose to do? 

o    You need to install the ERA Update 

                                          i.     SU 1.1 ï IPT Certificate and Reports  
                                         ii.     SU 1.2 ï QOES Presenta tion Graphics  

  
o    You can get these updates at ERAôs support website   http://rkcl.in  

  

56. When will the midterm exam be available in learner’s login? 
o   You will be intimated through e-mail or through your Solar Login. 
o    After that, you login to ERA using your Learning Facilitator Login Id. 
o   Go to Academics -> Enable Mid Term Examination 

  Enter the Center Password and click on Download. 

http://elearning.mkcl.org/support/MSCIT/updates.htm
http://rkcl.in/
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  A Message of successful installation is shown. 

 

57. I have enabled the Mid Term exam from the LF login, but still it is not enabled for some 
learners, what am I suppose to do? 
o   This is because these learners are ‘Not Confirmed and Active’ Learners. You can check this 

status from the LF Login >> Tutoring>>Reports>> Learner Login Report. 

o   To make the learners Confirmed and Active, you need to install ‘ERA Utility for Learner 

Status Updating  ‘. You can get this update at ERA support website 
http://rkcl.in 

o   Install this update on your server machine and try selecting the Mid Term Exam again. 

58. While installing the ERA V 3.0 updates from the support website, I am getting the error 
‘Unhandeled exceptionhas occurred in your application…………….Cannot create Active X 
component.’, what am I suppose to do? 

 

o   You need to install the following patch, and then try installing the respective update again. 
Select the operating system on your server machine 

o   Windows Server 2003 

http://rkcl.in/
http://www.microsoft.com/downloads/details.aspx?familyid=887fce82-e3f5-4289-a5e3-6cbb818623aa&displaylang=en
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o   Windows XP 
  

59. While answering the Practical Question,  of  IPT I am getting the error, “Cannot create 
Active X component”. What should I do? 

  

 
o   This message will come while solving the Practical Questions of Microsoft Office. 

o   Your machine does not have Microsoft Office installed on your machine. 
o   Install Microsoft Office. And try again. 
  

  

Dashboard 

60. How are calculations done for Learning Progression Dashboard. 
o   Following is the calculation methodology for Learning Progression Dashboard: 

  Example: Consider a Learner has spent 2 Hours on Learning and has completed 20% of total 
course. 

   % Time Spent =(Time spent by the user/ Total expected time)*100 

= (120 mins/900 mins)*100 

= 13.33 

   % Course Completion = 20 
  

   % Learning (Average of Time spent and Course completion) = (13.33+20)/2=16.66  

   Marks for Learning Process = 15X16.66/100  

   Marks for Learning Process will be : 2.5 out of 15 
  

http://www.microsoft.com/downloads/details.aspx?FamilyId=C717D943-7E4B-4622-86EB-95A22B832CAA&displaylang=en
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61. How are calculations done for Assessment Dashboard. 
o   Following is the calculation methodology for Assessment Dashboard: 

  
   Marks obtained for IPT= (Actual Total Marks Obtained in All IPTs/ Maximum Total Marks 

for 
                                                all 8 IPTs) X Weightage of IPT in Final Score.  
                                

             = ((M1+ ….+M8) / 200) X 10 
  

   Example : If a Learner gets a total of 100 marks in all IPT’s he has attempted, then his 
Marks in Final Score will be 

 (100/200)*10=5 

  Marks for IPT will be : 5 out of 10 

62. What all is to be uploaded to ERA Central Server, so that all the reports in LF Login and 
the Dashboard in Learner Login shows correct data. 

o   Once the Learner has started learning, the Learning Facilitator should upload the following 
  Learning Records :  These can be uploaded through 

LF Login >> Academics >> Upload Manager >> Upload Learning 
Records 
  

  Dash Board Data : These can be uploaded through 
LF Login >> Academics >> Upload Manager >> Upload Dash Board 
Data 
  

o   Once the learner starts giving the IPT then the Learning Facilitator, along with the above 
mentioned record should also upload the IPT Marks. These can be uploaded through 

LF Login >> Academics >> Upload Manager >> Upload IPT Marks 

63. The dashboard is showing IPT score as 0 , even when learner have solved the IPT and 
his marks have been uploaded. How to correct the dashboard. 

o    You need to install the ERA Update 

  SU 1.1 ï IPT Certificate and Reports  
  SU 1.2 ï QOES Presentation Graphics  

  
o    You can get these updates at ERAôs support website   http://rkcl.in  

Uninstalling and Reinstalling ERA 3.0 

64. I want to uninstall ERA V 3.0 from my machine. I tried removing it using Start >> 
Control Panel >> Add Remove Programs. But it is not getting removed, some error is 
coming, what am I suppose to do? 

o   You can use Windows Installer Clean up utility to uninstall ERA V 3.0. 

o   You can download this utility from the following 
link http://support.microsoft.com/kb/290301 

o   Once its installed, go to Start >> ALL Programs >>  Windows Install Clean Up 

http://rkcl.in/
http://support.microsoft.com/kb/290301
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o   Select RSCIT-ERA3 and click on Remove. 

 

o   Click on OK, ERA V 3.0 will be removed from your machine. 

 

65. Due to some reason I have uninstalled the ERA and trying to re-installed it but some 
error is coming while reinstallation. 

o   After uninstalling the ERA, sometimes actual folders does not get delete. This might 
create problem while re-installation of ERA. 

o   You need to delete the following folders after installation and before re-installation. 

o   C:\inetpub\wwwroot  RSCIT-ERA3 (Delete this folder) 

66. If I want to shift my ERA V 3.0 Server from the current machine to other machine, what 
all I need to do. 

o   Uninstall ERA 3.0 from the current machine. 
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o   Ensure that all prerequisites for ERA V 3.0 (for details, refer Before Installing ERA V 3.0 
section in this document) are fulfilled on the other machine and then install ERA V 3.0 
in the other machine. 

o   Only 2 ERA reactivations are allowed in any center, so if you have already activated twice, 
send a mail to the RLC to allow activation for your center. 

o   For all the client machines( and server machine if Quasi OES Client is installed in it) do the 
following: 

  Go to the following folder 
C:\Documents and Settings\bhavnad\Local Settings\Apps\2.0 

 

  
1.       Here bhavnad is the user name. 
2.       Delete the two folders Data and X9E1TY3R.3KH. 
3.       Now reinstall QuasiOES Client. 

  
67. I have reinstalled ERA V 3.0 on my machine, do I need to reinstall the Updates also. 

o   Whenever ERA V 3.0 is reinstalled all the compulsory updates needs to be installed. 
o   All the Updates are available on our support website .  http://rkcl.in 

  

Backup of ERA V 3.0 

68. The backup of ERAV 3.0 got corrupted, where can I get a copy of auto back up of ERA V 
3.0? 

o   An auto back of ERA 3.0 is taken with a gap of 3 days. To get this back up do the 
following. 

                                                         i.            Go to C:\ Documents and Settings\  In the menu go to Tools >> Folder 
Options… 
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  In the View tab, go to Advanced settings, uncheck the option, ‘Hide protected 
operating system files(Recommended)’ . Click on ‘Apply’ and then on ‘OK’. 

 

  Now inside C:\  Documents and Settings go to the following 
folder, LocalService\ Application Data\ RSCIT-ERA 3_Backup 
This folder has an auto backup copy of ERA V 3.0 and also the log of it. 

 

  
o   If you do not find the ERA V 3.0 back up here then, do the following 

                                                         i.            Go to Windows Start  >> Run and run services.msc 
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  Check if the Startup Type status of service RSCIT ERA is set to ‘Automatic’. 

 

  If it is not ‘Automatic’, then right click on the service and go to Properties 

 

  Set the Startup Type to ‘Automatic’. Click on Ok. 



 

Page 46 of 47 
Website : - http://www.rkcl.in                                               Contact : - 0141-5159700 

Corporate Office : - R.K.C.L. , 7-A , Jhalana Institutional Area , Jaipur-302004 (Raj.) INDIA 

 

  Restart the machine. 
  Look for the auto backup file again, as mentioned above. 

  

69. How to take the manual backup of the ERA Database files. 

OR 

I have tried to take backup using Data Traveler, but it is not working, then I checked 
for   the Auto back up, but it is also not getting generated. How will I get the backup now? 

  

  

o   In this case you can save the RSCIT_ERA3_Data.mdf and RSCIT_ERA3_Log.ldf files. 
o   Before saving these files first you need to stop the services for MSSQL$ERA3. 

o   Go to Start Run, type ‘ǎŜǊǾƛŎŜǎΦƳǎŎΩΣ click on ok 

o   Right click on the service MSSQL$ERA3 and Stop the service. 
o   Now save the files MSCIT_ERA3_Data.mdf and MSCIT_ERA3_Log.ldf of your server machine. 

C:\ Program Files\ Microsoft SQL Server\ MSSQL$ERA3\ Data 
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o   Once you have saved this file, you need to restart the service MSSQL$ERA3. 
o   To restore the backup, again you first need to stop the service MSSQL$ERA3, paste the files here 

and again start the service MSSQL$ERA3. 
  

 


